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Notice 

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of 
these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or 
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or 
others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depend on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 
electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 
financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; 
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims 
any and all liability for any damage or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is 
inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not 
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT 
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products 
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, 
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety 
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging 
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10.Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11.Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12.It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13.This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14.Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 
(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.5.0-1  October 2020) 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-
to-date version of a document, or your nearest sales office, 
please visit: www.renesas.com/contact/. 

Trademarks   

Renesas and the Renesas logo are trademarks of Renesas 
Electronics Corporation. All trademarks and registered 
trademarks are the property of their respective owners. 
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Renesas EK-RA8P1 
 
By using this EK-RA8P1, the User accepts the following terms, which are in addition to, and control in the event of disagreement, with Renesas’ General 
Terms and Conditions available at https://www.renesas.com/en-us/legal/disclaimer.html.  
 
The EK-RA8P1 is not guaranteed to be error free, and the entire risk as to the results and performance of the EK-RA8P1 is assumed by the User. The EK-
RA8P1 is provided by Renesas on an “as is” basis without warranty of any kind whether express or implied, including but not limited to the implied 
warranties of good workmanship, fitness for a particular purpose, title, merchantability, and non-infringement of intellectual property rights. Renesas 
expressly disclaims any implied warranty.  
 
Renesas does not consider the EK-RA8P1 to be a finished product and therefore the EK-RA8P1 may not comply with some requirements applicable to 
finished products, including, but not limited to recycling, restricted substances and electromagnetic compatibility regulations. Refer to Certifications section, 
for information about certifications and compliance information for the EK-RA8P1. It is the kit User’s responsibility to make sure the kit meets any local 
requirements applicable to their region. 
 
Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, loss of contract, loss of business, damage to reputation or goodwill, any 
economic loss, any reprogramming or recall costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any 
other direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this EK-RA8P1, even if Renesas or its affiliates 
have been advised of the possibility of such damages. 

 
Renesas has used reasonable care in preparing the information included in this document, but Renesas does not warrant that such information is error free 
nor does Renesas guarantee an exact match for every application or parameter to part numbers designated by other vendors listed herein. The information 
provided in this document is intended solely to enable the use of Renesas products. No express or implied license to any intellectual property right is 
granted by this document or in connection with the sale of Renesas products. Renesas reserves the right to make changes to specifications and product 
descriptions at any time without notice. Renesas assumes no liability for any damages incurred by you resulting from errors in or omissions from the 
information included herein. Renesas cannot verify, and assumes no liability for, the accuracy of information available on another company’s website. 
 

Precautions 
 
This Evaluation Kit is only intended for use in a laboratory environment under ambient temperature and humidity conditions. A safe separation distance 
should be used between this and any sensitive equipment. Its use outside the laboratory, classroom, study area, or similar such area invalidates conformity 
with the protection requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.  
The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio communications. There is no guarantee 
that interference will not occur in a particular installation. If this equipment causes harmful interference to radio or television reception, which can be 
determined by turning the equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures: 
 • Ensure attached cables do not lie across the equipment. 
 • Reorient the receiving antenna. 
 • Increase the distance between the equipment and the receiver. 
 • Connect the equipment into an outlet on a circuit different from that which the receiver is connected. 
 • Power down the equipment when not in use. 
 • Consult the dealer or an experienced radio/TV technician for help.  
Note: It is recommended that wherever possible shielded interface cables are used. 
The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the following measures be undertaken: 
 • The user is advised that mobile phones should not be used within 10 m of the product when in use. 
 • The user is advised to take ESD precautions when handling the equipment.  
The Evaluation Kit does not represent an ideal reference design for an end product and does not fulfill the regulatory standards for an end product. 
  

https://www.renesas.com/en-us/legal/disclaimer.html
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1.Precaution against Electrostatic Discharge (ESD) 
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must 
be taken to stop the generation of static electricity as much as possible and quickly dissipate it when it occurs. Environmental control must be adequate. 
When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices 
must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work 
benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare 
hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2.Processing at power-on 
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, 
the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a 
product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at 
which resetting is specified. 

3.Input of signal during power-off state 
Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-
up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow 
the guideline for input signal during power-off state as described in your product documentation. 

4.Handling of unused pins 
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in 
the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an 
associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible. 

5.Clock signals 
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a 
reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an 
external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6.Voltage application waveform at input pin 
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL (Max.) 
and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is 
fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7.Prohibition of access to reserved addresses 
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 
addresses as the correct operation of the LSI is not guaranteed. 

8.Differences between products 
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The 
characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of 
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating 
margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for 
the given product. 
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1. Introduction 

This Quick Start Guide (QSG) provides a practical introduction to the Renesas RUHMI (Robust Unified 
Heterogeneous Model Integration) framework, in which AI compiler is by powered by EdgeCortix® MERA™.  
and it is optimized for Renesas RA microcontrollers. 
 
The guide covers: 

• An overview of RUHMI Framework's key features, including model quantization, compilation, and C 
source code generation. 

• Step-by-step instructions for installing and running RUHMI Framework in both Linux and Windows 
environments. 

• Usage of AI application example for deploying TensorFlow Lite, ONNX, and PyTorch/ExecuTorch 
models with optional acceleration using Arm® Ethos-U55. 

• Usage of RHUMI framework with your AI model and your project. 

 

1.1 Assumptions and Advisory Notes 

To use RUHMI Framework effectively, the following conditions and knowledge are assumed: 

1. Tool experience: Users are expected to have prior experience with embedded development and AI 
model training using frameworks such as TensorFlow or PyTorch/ExecuTorch.  

2. Model access: It is assumed that users already possess or have access to pre-trained models in 
TensorFlow Lite (.tflite), ONNX (.onnx) ,  PyTorch/ExecuTorch(.pte) format. 

3. Subject knowledge: Familiarity with microcontroller-based systems, C programming, and Renesas 
Smart Configurator tools are required. 

4. Supported platforms: RUHMI Framework targets Renesas RA family MCUs. Optional support for the 
Arm® Ethos-U55 NPU is available through the Arm Vela compiler. Verify hardware compatibility 
before use. 

5. Software versioning: Always use the latest version of RUHMI Framework to ensure compatibility with 
supported models, libraries, and runtime tools. 

6. Screen references: Figures and UI examples in this guide are for reference only. Actual screen 
layouts or paths may differ depending on the software version. 
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2. RUHMI Framework Overview  

RUHMI (Robust Unified Heterogeneous Model Integration) Framework is a model deployment toolchain 
developed to enable AI model deployment on embedded processors. It enables efficient and scalable 
deployment of machine learning models on edge devices with limited memory and power budgets. RUHMI 
Framework’s first backend iteration has been optimized to support Renesas RA8 series of microcontrollers 
by leveraging a modified version of MERA™2.0 from Renesas partner EdgeCortix®. 
 
RUHMI Framework supports widely used model formats including TensorFlow Lite, ONNX, and  
PyTorch/ExecuTorch. It is also capable of deploying models to both CPU-only and CPU+NPU (Arm® Ethos-
U55) configurations.  
 
RUHMI Framework is ideal for real-time applications such as: 

⚫ Object detection 
⚫ Speech recognition 
⚫ Industrial and consumer edge AI use cases 

 
It is designed to minimize hardware-specific complexity while offering developers a flexible, framework-
agnostic toolchain. 
 

Key Features of RUHMI Framework  

• Supports FP32 (floating-point) and INT8 (quantized) inference 

• Automatically partitions operators between CPU and NPU based on hardware constraints 

• Generates optimized C/C++ source code for integration into e² studio projects 

• Uses CMSIS-NN and soft-float libraries for portable MCU inference 

• Supports external memory for large models beyond SRAM size 

• Built-in quantizer with PSNR-based validation for post-training quantization 

• Integrated utilities for reference data generation, runtime testing, and MCU verification 

• Seamless integration with TensorFlow Lite (.tflite), ONNX (.onnx) ,  PyTorch/ExecuTorch(.pte) 
format. 

• Compatible with both Linux CLI and Windows CLI / GUI (AI Navigator) environments 
 

The project example included in this guide demonstrates the following:  

Figure 2.1  RUHMI Framework Overview 

https://www.renesas.com/en/software-tool/ai-navigator-ide-ai-applications?srsltid=AfmBOoqmZMkKnh4RZNVmOh_CX3uM72--hkg27T588s5ZLiTZltnw2LgG
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(1) Import of a pre-trained AI model in the supported format 
(2) Post-training quantization using RUHMI Framework's built-in quantizer 
(3) Compilation into optimized C source code for Renesas RA8P1 platform 
(4) Generation of input/output reference data for validation 
(5) Deployment and execution on an evaluation board via Renesas e² studio 

 
You can get the software, the technical documentation and the application example project from GitHub 
repository, renesas/ruhmi-framework-mcu: Renesas RUHMI Framework supports AI model optimization and 
deployment, and is powered by EdgeCortix® MERA™ 
 

3. Running RUHMI Framework with Windows GUI: AI Navigator 

RUHMI Framework supports a GUI-based model deployment workflow via the AI Navigator in Renesas e² 
studio. This section explains how to import and convert an AI model (e.g. TFLite) using the GUI, and how to 
integrate it into your Renesas RA8P1 project. 

 
Hardware Requirements 

• EK-RA8P1 Evaluation Kit  
• USB-C to USB-C cable  
• A PC with at least one available USB port 
 

Software Requirements  

• Windows® 10 or 11 operating system or Ubuntu 22.04 LTS 
• Renesas e² studio version: 2026-04.02 or later 
• Flexible Software Package (FSP): 6.4.0 or later. 

o Refer to the webpage (RA Flexible Software Package Documentation) for the details. 
• AI Navigator v2.2.0 for GUI 

o Visit the AI Navigator web page (AI Navigator: IDE for AI Applications | Renesas) and 
download the release note. It includes the features, changes, additional notes, and more. 

 

3.1 Introduction 

AI Navigator is a set of plugins for e2 studio that makes it easy to develop the edge AI application with 
Renesas devices. One of the plugins, AI Model Conversion Tool Plugin uses RUHMI Framework to provide 
AI model conversion feature. 
The development steps using AI Navigator are shown below. All steps can be controlled by the AI Navigator. 
 

 

Figure 3.1 AI Navigator development flow  

 

https://www.renesas.com/en/software-tool/e-studio?srsltid=AfmBOoo2locf3Aej7-44jQPb9wdN32rA_q-yyGgqGNJ7XU2Yw8mZa-xR#overview
https://github.com/renesas/ruhmi-framework-mcu
https://github.com/renesas/ruhmi-framework-mcu
https://www.renesas.com/en/software-tool/ai-navigator-ide-ai-applications
https://renesas.github.io/fsp/
https://www.renesas.com/en/software-tool/ai-navigator-ide-ai-applications
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3.2 Installation 

• New e2 studio users 
Download e2 studio 2025-10 from the following link:  
 - Windows: e² studio 2026-04.2 installer for Windows  
 - Linux (Ubuntu 22.04 LTS): e² studio 2026-04.2 installer for Linux 
After downloading, install e2 studio. 
Select the following each item when installing. 
- Device Family: RA 
- Additional Software: Renesas AI Navigator, AI Model Conversion Tool Plugin, and Renesas FSP 
v6.4.0 or later 
 
• e2 studio users 
Download and install FSP v6.4.0 or later. 
Then, add the necessary plugins by following the steps below.: 
1. Launch e2 studio. 
2. Click [Help] > [Install New Software ...].   
 

 
Figure 3.2 Install IDE feature (1) 

 
3. Click "Add..." and enter the following URLs in Location. 

- AI Navigator Plugin: https://tool-support.renesas.com/e2studio/ai/ai-navi 
- AI Model Conversion Tool Plugin: https://tool-support.renesas.com/e2studio/ai/rz_tvm 

4. Check the target plugin and click [Next]. 
 

 

Figure 3.3 Install IDE feature (2) 

https://www.renesas.com/en/document/uid/e-studio-2025-07-installer-windows?r=488826
https://www.renesas.com/en/document/uid/e-studio-2025-07-installer-windows?r=488826
https://www.renesas.com/en/document/uid/e-studio-2026-042-installer-windows?r=488826
https://www.renesas.com/en/document/uid/e-studio-2026-042-installer-linux?r=488826
https://tool-support.renesas.com/e2studio/ai/ai-navi
https://tool-support.renesas.com/e2studio/ai/rz_tvm
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5. Confirm the Install Details and click [Finish]. 
6. Read the license agreements and select "I accept the terms of the license agreement" if you agree. 

Then, click [Finish] to start the plugins installation. 
7. If the dialog of the trust certificate dialog appears during the installation, check the certificate and click 

[OK]. 
8. After the installation is finished, e2 studio will prompt you to restart. 
9. Click [Restart Now]. 

 

3.2.1 RUHMI update from Conversion Tool 

You can confirm the installation status in Conversion Tool. Open Conversion Tool from Renesas AI in the 
menu. 

 

 

Figure 3.4 Renesas AI menu 

 
Conversion Tool supports the auto installation feature for RUHMI.  
If RUHMI is not installed in the environment, AI Navigator will prompt you to install it. 
Select “Project Independent” or “Associate with e2 studio project” , choose Device (RA8P1 
(CPU+Ethos-U55) or RA8 Series (CPU Only)), and set Tools to “RUHMI Framework AI Compiler”. 
If RUHMI is not installed, the installation status will be displayed. 
Click [Setup Environment] and start the installation. RUHMI will be installed automatically. 

 

 

Figure 3.5  Auto installation 

 
Conversion Tool also supports the auto update feature for RUHMI. If the latest package of RUHMI has been 
available in the GitHub repository, Conversion Tool will notify the ready-ness. (Figure3.6 Update feature)  
Get RUHMI updated by clicking the update button. The update procedure will start automatically. 
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Figure 3.6 Update feature 

 

In case no longer RUHMI is needed, you can uninstall RUHMI AI compiler by clicking the Uninstallation 
button. (Figure 3.7 RUHMI Uninstallation) 

 

Figure 3.7 RUHMI Uninstallation 
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3.2.2 How to confirm the version of AI Navigator 

You can confirm the version of AI Navigator installed in your host by following steps. Open the dialog 
providing detailed information for e2 studio from Help menu in e2 studio. 

 

 

Figure 3.8 Help menu 

 

Click the button of Installation Detail. Figure 3.9 Check the installation detail. 

 

 

Figure 3.9 Check the installation detail 
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You can see the version information of AI Navigator installed in your host as below. 

 

Figure 3.10 AI Navigator version 

 

3.3 Getting Started 

This section explains how to integrate an AI model into your project with AI Navigator, including model 
conversion using RUHMI Framework on GUI. 
The following figure shows the workflow from opening to running on the board. It includes AI model 
conversion using RUHMI Framework. 
 

 
Figure 3.11 AI Navigator Workflow 
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3.3.1 Open AI Navigator 

Open e2 studio and your workspace.  
 
Click [Renesas AI] as shown in the figure below to launch AI Navigator and Conversion Tool. 
 

 

 
Figure 3.12 Opening AI Navigator 

 

AI Navigator  
This application provides you with selecting either sample application (AI application example) run and your 
project with your own converted model. 
 
Conversion Tool: 
This application provides the model conversion function with your own model input. 

 
 

A dialog box may appear asking you to switch perspectives. If you accept, click “Switch” to continue. 
 

 

Figure 3.13 Switch perspective dialog box 

 
AI Navigator will open. 
 

 
Figure 3.14 AI Navigator Welcome View 
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Note: If the Appearance Theme is set to "Light (Preview)", some GUI components such as buttons may not 
be displayed correctly.  
Please change Theme to "Light" or "Dark" from [Window] -> [Preferences] -> [General] -> [Appearance]. 

 
 

3.3.2 Import AI application Example 

There are two ways to import a project. 

• Select Sample AI Application (AI application Example) 

• Use Your Project & AI Model 

 

3.3.2.1 Select Sample AI Application (AI application Example) 

With EK-RA8P1, it can run the following two AI application examples.  

• Image classification 
• Face detection 

 
Using AI Navigator, you can import them into your workspace and run them onto the target board. 
Follow the instructions below to import. 

1. Click [Select Sample AI Application]. 
2. Enter keyword “RA8” in the filter field, and select a category of RA8 sample AI applications (AI 
Application Examples) based on your use case 
3. Enter keyword “RA8” in the filter field, and choose a RA8 sample AI application (AI Application 
Example).  
4. Click [Import]. 
5. The Project and AI information view like below will appear if the import is successful. 

 

 

Figure 3.15 Project and AI information view  

 

In case you just want to run the AI application example, click [Run on the Board] in the AI Navigator menu. 
(See 3.3.5 Run on the Board) 
If you want to convert an AI model, click [Convert AI Model…]. 
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3.3.2.2 Use Your Project & AI Model 

AI Navigator also provides the user project feature that allows users to develop AI Applications using your 
own projects, including own AI model. Follow the instructions below to prepare and import your project and 
AI model. 
 

1. Create or import an RA e2 studio project into your workspace. 
Note: Refer to RA Flexible Software Package Documentation for information about FSP project. 
Note: Add the following stacks if you use Ethos: 

    – Google TFLM Core Lib 

    – Google TFLM CMSIS-NN Kernel 

 
Once added, the required dependent stacks (such as ARM Ethos-U Core Driver, ARM CMSIS NN 
Library Source, ARM CMSIS DPS Library Source) will be included automatically. You can refer Using 
the Ethos-U NPU with RA8 MCUs to get more information. 

 
2. Click [Use Your Project & AI Model] in the AI Navigator Welcome View. 
3. Select your project prepared in 1. and click [Finish]. 

 

 
Figure 3.16 Select your project window 

 

4. Click [Use AI Model on Your PC]. 

 

 
Figure 3.17 Use AI Model on Your PC 

 

5. Select your AI model (*.tflite / *.onnx / *.pte). 
Note: Please avoid using spaces in your AI model name. The AI model conversion may not succeed. 
 
6. The Project and AI information view will appear when the project and AI model are imported successfully. 

click 

https://renesas.github.io/fsp/
https://www.renesas.com/en/document/apn/using-ethos-u-npu-ra8-mcus?r=25574019
https://www.renesas.com/en/document/apn/using-ethos-u-npu-ra8-mcus?r=25574019
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Figure 3.18 Project and AI information view (Use your project & AI model) 

 

3.3.3 Conversion 

After the setup, click [Convert…] and Conversion Tool will open. 
Follow below three steps to convert AI model once Conversion Tool opens. These steps are also shown 
in the left-side menu in the figure (Figure 3.19 Conversion Tool). 

(1) Input file settings 
(2) Optimization 
(3) Conversion 

 

(1) Input file settings 

With reference to Figure 3.19 Conversion Tool, please set the following settings in this view. After setting, 
click [Next]. 

• Project Independent / Associate with e2 studio project:  
If you are using an e² studio project, select it in “Associate with e² studio project”. 

• Device:  Set your device 
     You can see two options in the pull-down menu as Figure 3.20 Device setting. 

- RA8P1 (CPU+Ethos-U55):  Using RA8P1 
- RA8 series (CPU only): RA8 series MCU without Ethos-U55 

• Tools:  RUHMI Framwork AI Compiler 
• Framework selection: Select your mode framework. 
     ONNX (.onnx), TensorFlow Lite (.tflite), PyTorch(.pth/.py), ExcuTorch(.pte) 
• Input model file:    Click [Browse] and select your target AI model. 
     You can select the model file of the your selected framework type. 
• Output directory:    Specify the output directory for the conversion result. 
               You cannot put any space in the folder name. 

 

 
 Figure 3.19 Conversion Tool 
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Figure 3.20 Device setting 

 
(2) Optimization 

In this view, you can perform quantization as needed to prepare your AI model into an optimized format. 
If you select a quantized model as the input model file in the previous view, confirm that the message 
indicating a quantized AI model was loaded in Quantization result, and click [Next]. ( Optimization (input file: 
a non-quantized model)) 
 
If you select a non-quantized model, perform quantization in this view. Set each parameter and click [Start 
Quantization]. If quantization is successful, a message as shown in Figure 3.22 Optimization (input file: a 
non-quantized model) will appear. Click [Next] to continue.  
 
Note: Click [Learn more…] in this view and open AI Model Conversion Tool Help.  
Refer to View 2: Optimization (Quantization) for the details about quantization. 
 

 

Figure 3.21 Optimization (input file: a quantized model)  
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Figure 3.22 Optimization (input file: a non-quantized model)  

 
 
(3) Conversion 

Configure the following options as needed before conversion. 
 

The optimization options depends on the conversion mode. 
Case 1) Use CPU+ Ethos-U55 
• Optimize mode:  

- Performance:  (default) Optimize for maximum performance. 
- Size:   Optimized for minimal RAM usage. 

• Memory mode: 
- Sram_Only:  (default) Specify when placing weights in the internal ROM. 
- Shared_Sram:  Specify when placing weights in the external ROM. 

 
Case 2) Use CPU only 
• Weight location (*for using CPU only) : 

- ROM:  (default) Neural network weight data is stored in ROM. 
- RAM:  Neural network weight data is stored in RAM. 

 
Additional options:  
Click [Browse] and select your target AI model. 
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Figure 3.23 Conversion options 

 

After setting options, click [Start Conversion]. If the conversion is successful, a message indicating 
success will appear in the “Conversion result” section, as shown in the figure below. 
 

 

Figure 3.24 Conversion completed 

 
You can see the conversion log in the folder which you can open by clicking [Open Log Folder…]. The log 
file there should be helpful to get the support from Renesas. 
 
In addition, you can click [Open Model Visualizer…] to view the structure of the converted model. 
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3.3.4 Edit your application 

 After conversion, edit your application source code including the implementation of AI model (C/C++), and 
build your project.  
 

 

Figure 3.25 Edit Application 

 

1. Click [Edit Application] in the AI Navigator menu.  
2. Click [How to Implement AI Model…]  to open “How to Implement AI model”. This document describes 

the steps from integrating the converted output code via RUHMI Framework to executing AI inference. 
3. Modify the source code. When clicking [Edit…], hal_entry.c will open. Integrate the AI model. 
4. Click [Build]. The build result will be shown in the console. 
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3.3.5 Run on the Board 

 

 
Figure 3.26 Run on the AI App 

 

To run your AI Application on the target board,  

1. Connect EK-RA8P1. 
2. Click [Run on the Board] in the AI Navigator menu.  
3. In the Debug AI view, click [Run the AI App] to start inference. 

 

Note: When you try to run an RA8P1 AI application example via the [Run the AI App] button, the build 
process will start automatically before debugging. To skip this auto build: 
 
1. Open Debug Configurations. 
2. Select your project in Renesas GDB Hardware Debugging. 
3. Go to Main tab. 
4. Choose “Disable auto build” or “Use workspace settings” in Build (if required) before launching. 

 
  



Renesas RA Family                                                              Renesas RUHMI Framework – Quick Start Guide 

R11QS0065EJ0102  Page 24 of 34 
Jun. 05 2026   

3.4 NOTE: Common problems for Ubuntu 

3.4.1 Toolchain paths missing 

If the following error appears in the [Console] view when building the application, the toolchain path may not 
be set. 

 

Figure 3.27 Toolchain error 

 

It can be set from the [Help] > [Add Renesas Toolchains] menu. Please set the toolchain paths as shown in 
the image below.  
 

 

Figure 3.28 Add Renesas Toolchains 

 

 

Figure 3.29 Add Toolchains for LLVM and GNU ARM 

 
Note: If you install the toolchains using the e2 studio installer, the toolchains will be installed in the same 
directory where e2 studio is installed.  
By default, they are installed in the “~/.local/share/renesas/e2_studio/toolchains/” folder. 
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3.4.2 SEGGER J-Link USB permission missing 

 
If the following error occurs while debugging the application, the SEGGER J-Link USB device may not have 
write permissions as one of the possible causes other than the listed possible causes in the dialog. 
 
If the following error occurs while debugging the application, one possible cause, other than those listed in 
the dialog, is that the SEGGER J-Link USB device does not have write permissions. 
 

 
Figure 3.30 Connection Error 

 
You can verify the permissions as follows: 
 
1. Check that the SEGGER J-Link USB device is recognized, and note the bus and device numbers. 
 

$ lsusb | grep -i segger 
Bus 003 Device 008: ID 1366:1024 SEGGER J-Link 

 
2. Check the permissions for the SEGGER J-Link USB device node. 
 

$ ls -l /dev/bus/usb/*/*  | grep 003/008 

crw-rw-r-- 1 root root ... /dev/bus/usb/003/008 

 
 
If the user permissions are “r--”, you do not have write access to the SEGGER J-Link USB device. 
 
If you have not installed the SEGGER J-Link USB driver, install it by following the guide below: 
• e² studio Quick Start Guide for the Linux Hosted Version of the e² studio Application Note : Chapter 7.2 
 
After installing it, unplug and plug it back in, and then verify that the permissions have changed to “rw-”. 

  

https://www.renesas.com/en/document/mat/quick-start-guide-linux-hosted-version-e-studio?r=488826
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4. Running the sample script by CLI interface 

Without GUI interface provided by AI navigator, you can use RUHMI framework to convert AI model with CLI 
interface from the GitHub repository. You can install RUHMI with CLI interface supported by manual 
insulation following the coming section. 

renesas/ruhmi-framework-mcu: Renesas RUHMI Framework supports AI model optimization and 
deployment, and is powered by EdgeCortix® MERA™ 

 

4.1 Software Requirements 

• Windows® 10 or 11 operating system or Ubuntu 22.04 LTS. 
• Flexible Software Package (FSP): 6.1.0 

 

4.2 Downloading and Installing Software and Development Tools 

Before modifying or running the sample scripts, it is necessary to download and install the required software 
and development tools on the host PC. RUHMI Framework supports installation and usage in the following 
environments: 

Platform 
Interface 
Type 

Description 

Linux (Ubuntu 22.04 ) CLI 
Full-featured environment. Recommended for advanced users and 
automation.  

Windows CLI 
Suitable for scripting and model testing. Requires Python + VC 
Redistributable. 

Windows GUI 
Integrated into e² studio. Ideal for beginners and visual, step-by-step 
setup. 

 

4.2.1 Linux CLI Installation 

Get the installation file from GitHub and place it in your PC. 
GitHub repository: ruhmi-framework-mcu/install at main · renesas/ruhmi-framework-mcu 
Installation files for Linux:  mera-x.y.z+pkg.nnnn-cp310-cp310-manylinux_2_27_x86_64.whl 
 
NOTE: x, y, z and nnnn mean the version number.  
 (e.g. mera-2.4.0+pkg.1756-cp310-cp310-manylinux_2_27_x86_64.whl) 
 
Update the package index to ensure your system has the latest information about available software 
packages. and installs essential development tools such as GCC, and Make (build-essential), along with 
CMake, which is a tool used to manage build processes for compiling source code. Run the following 
commands: 

sudo apt update 
sudo apt install build-essential cmake python3-venv python3-pip 

 
Recommended: use the default Python installation 
Because MERATM software stack is compatible by default with the base system Python version provided by 
Ubuntu 22.04 we can create a virtual environment as follows:  
 

sudo add-apt-repository -yu ppa:ubuntu-toolchain-r/test 
sudo add-apt-repository ppa:deadsnakes/ppa 
sudo apt update && sudo apt upgrade 
sudo apt-get install -q -y --only-upgrade libstdc++6 libgcc-s1 
sudo apt update && sudo apt upgrade 
sudo apt build-essential gcc-13 g++-13 
sudo apt-get install python3.10 python3.10-venv python3.10-dev python3-pip 
python3.10 -m venv mera-env 
source mera-env/bin/activate 
pip install --upgrade pip && pip install decorator typing_extensions psutil attrs pybind11 cmake 

 

https://github.com/renesas/ruhmi-framework-mcu
https://github.com/renesas/ruhmi-framework-mcu
https://github.com/renesas/ruhmi-framework-mcu/tree/main/install
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Your prompt should now show that you are under a virtual environment mera-env: (mera-env) 
user@compute:~$ 
 
Install MERA 
Finally install MERA on the virtual environment mera-env: 

pip install ./mera-2.4.0+pkg.1756-cp310-cp310-manylinux_2_27_x86_64.whl   

 
NOTE: In this case, the installation file is “mera-2.4.0+pkg.1756-cp310-cp310-manylinux_2_27_x86_64.whl”. 

 The suffix number of the file depends on the package version. 
 
At this point MERA should be ready to use. You can confirm with the following example: 

python -c "import mera; print(mera.__version__)”     
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4.2.1.1   

Download the Microsoft Visual C++ Redistributable  
 
Note: You must download vc_redist.x64.exe since RUHMI Framework’s MERA™2.0 backend only supports 
X64 architecture PCs 

• Run the download exe file to install Redistributable package. 
Microsoft Visual C++ Redistributable latest supported download 

 
Install Python 3.10.5 
Download Python installer, Windows installer (64-bit), from Python Release Python 3.10.5 | Python.org.  
Then install it on your PC. 
 
Open PowerShell from the windows start menu. Create and move it to the working folder. Assuming 
C:\work is the current folder in the following process. You can confirm python is ready with the intended 
version. 

PS <current directory>> cd C:\work    
PS C:\work> python --version 
Python 3.10.5 

 
Prepare the virtual environment.  
Build the virtual environment under the working directory. 

 
Before activating the virtual environment, you may need to change the execution policy for shell execution. 

Your prompt should now show that you are under a virtual environment mera-env: (.venv) PS C:\work> 
 
 
Install MERA backend and dependencies 
Get the installation file from GitHub and place it on your PC. 
 
GitHub repository: ruhmi-framework-mcu/install at main · renesas/ruhmi-framework-mcu 
Installation files for Windows:  mera-x.y.z+pkg.nnn-cp310-cp310-win_amd64.whl 
 
NOTE: The file name may vary depending on the release version. x, y, z and nnn mean the version number. 
 (e.g. mera-2.4.0+pkg.179-cp310-cp310-win_amd64.whl) 
 
To configure the environment variables for e2studio, the following command is needed. 
 
 
 
 
Put the installation file in the working directory. 
In PowerShell, run the following commands to install MERA. The file name should be as the actual name in 
your place. The suffix of the installation file may vary depending on the release version. 

python -m pip install .\mera-x.y.z+pkg.nnn-cp310-cp310-win_amd64.whl 
python -m pip install onnx==1.17.0 tflite==2.18.0 

 
You can confirm the installed RUHMI release version, vera version and all your path settings of your 
environment by the following commands. 

python -c "import mera; print(mera.__version__)”   
2.4.0+pkg.179   
 
vela --version 
4.2.0  

py -3.10 -m venv .venv 

Set-ExecutionPolicy -ExecutionPolicy RemoteSigned -Scope Process   
.venv\Scripts\Activate.ps1 

[Environment]::SetEnvironmentVariable('CONVERSION_TOOL_E2STUDIO_PLUGIN_PYTHON_VENV_
LOC', "$(Get-Location)", 'User') 
 

https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
https://www.python.org/ftp/python/3.10.5/python-3.10.5-amd64.exe
https://www.python.org/downloads/release/python-3105/
https://github.com/renesas/ruhmi-framework-mcu/tree/main/install
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4.3 Using Sample script for Linux and Windows CLI 

RUHMI Framework provides Python-based command-line tools to help users deploy AI models on Renesas 
RA8 MCUs with or without acceleration by Arm® Ethos-U55. The sample scripts are: 

• mcu_deploy.py: for deploying non-quantized (FP32) models 

• mcu_quantize.py: for quantizing models and deploying optimized C code 
Both scripts support additional options for reference data generation and memory configurations. 
You can get the sample scripts from ruhmi-framework-mcu/scripts at main · renesas/ruhmi-framework-mcu. 
 

4.3.1 Compiling Non-Quantized Models 

To deploy a pre-trained model without quantization: 

python scripts/mcu_deploy.py --ethos --ref_data models/ output_dir/ 

 

Option Description 

--ethos Enables code generation for Arm Ethos-U55 

--ref_data Generates input/output .npy files for testing 

models/ Directory containing .tflite model files 

output_dir/ Output folder where C code and test data are saved 

 

4.3.2 Quantizing and Compiling Models 

To quantize a TFLite, ONNX, or Executorch (.pte) model and compile it for MCU:. 
Example command: 

python scripts/mcu_quantize.py models_fp32/ compiled_models/ -c 5 --ethos --ref_data 

 

Option Description 

-c, --calib_num Number of random samples used for calibration (default: 5) 

--ethos Target Arm Ethos-U55 for accelerated subgraphs 

--ref_data Generate C99-format reference input/output for validation 

models_fp32/ Input folder with FP32 models (.tflite, .onnx, .pte) 

compiled_models/ Output folder for quantized and compiled results 

 

4.4 Deployment Output Structure 

After running the scripts, the following folder and file structure will be generated for each model. These 
represent the C source code, headers, and supporting files necessary to integrate the model into an MCU 
project. 
 
 

deploy/ 
├── person-det_no_ospi 
│   ├── build 
│   │   └── MCU 
│   │       ├── compilation 
│   │       │   ├── mera.plan 
│   │       │   ├── src 
│   │       │   │   ├── compute_sub_0000.c [Copy onto your source folder] 
│   │       │   │   ├── compute_sub_0000.h [Copy onto your source folder] 
│   │       │   │   ├── ethosu_common.h [Copy onto your source folder] 
│   │       │   │   ├── hal_entry.c  [NOTE] This is just a reference and NOT needed copied. 
│   │       │   │   ├── kernel_library_int.c [Copy onto your source folder] 
│   │       │   │   ├── model.c   [Copy onto your source folder] 
│   │       │   │   ├── model.h   [Copy onto your source folder] 
│   │       │   │   ├── model_io_data.c  [Copy onto your source folder] 
│   │       │   │   ├── model_io_data.h  [Copy onto your source folder] 

https://github.com/renesas/ruhmi-framework-mcu/tree/main/scripts
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│   │       │   │   ├── sub_0001_command_stream.c [Copy onto your source folder] 
│   │       │   │   ├── sub_0001_command_stream.h [Copy onto your source folder] 
│   │       │   │   ├── sub_0001_invoke.c  [Copy onto your source folder] 
│   │       │   │   ├── sub_0001_invoke.h [Copy onto your source folder] 
│   │       ├── deploy_cfg.json 
│   │       ├── ir_dumps 
│   │       │   ├── person-det_can.dot 
│   │       │   ├── ... 
│   │       ├── person-det_after_canonicalization.dot 
│   │       └── person-det_subgraphs.dot 
│   ├── logs 
│   ├── model 
│   │   └── input_desc.json 
│   └── project.mdp 
 
 
You will copy all files under the folder of <deployment_directory>/build/MCU/compilation/src. other than 
hal_entry.c onto your source folder. 
Please note that the file names and the number of files depend on the input model and the conversion mode. 
 

4.5 Generated inference API (Ethos-U Enabled) 

If Ethos-U support is enabled during conversion into source code with the compiler then an arbitrary number 
of subgraphs for either CPU or Ethos-U will be generated. Each of these subgraphs will correspond to 
generated C functions to run the corresponding section of the model on CPU or Ethos. Each function call will 
get its input from previous outputs of other subgraphs and write its outputs on buffers that are designated to 
become again inputs to other functions and so on. To make easier for the user to invoke these models 
where CPU and NPU are involved, the generated code will automate this process and provide a single 
function that will orchestrate the calls to the different computation units named void RunModel(bool 
clean_outputs) and helpers to access to each of the input and output areas at model level not per subgraph 
level. The runtime API header where Ethos-U is enabled can be found on a file named model.h under the 
same directory <deployment_directory>/build/MCU/compilation/src. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.6 Generated inference API (CPU-Only) 

When a model is converted into source code with RUHMI framework without Ethos-U support, all the 
operators in the model are mapped to run on CPU only. In this case, the generated code will refer to a single 
subgraph compute_sub_0000, by default, when no suffix is provided, the name of the header to be included 
on your application entry point is defined in compute_sub_0000.h. 

This header, model.h, provides the declaration of a C function that if called will run the model with the 
provided inputs and write the results on the output buffers provided. 

 

 

 

 

void RunModel(bool clean_outputs); 
 
  // Model input pointers 
float* GetModelInputPtr_input_1(); 
 
  // Model output pointers 
float* GetModelOutputPtr_Identity_70029(); 

memcpy(GetModelInputPtr_input_1(), model_input0, model_input_SIZE0);   
//Set the input model to the pointer for the compiler   

                                           //Will be set the output data to the GetModelOutputPtr_Identity_70029()   

RunModel();  //Execution   

Example 1: Definition of input/output buffers (in the file of model.h) 

Example 2: Source code 
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It provides the users with the possibility of providing a buffer to hold intermediate outputs of the model. And 
this size if provided in compilation time as the value kBufferSize_sub_0000 so the user can use this size to 
allocate the buffer on the stack, the heap or a custom data section. 

 

 

 

 

 

5. Website and Support 

Visit the following URLs to learn about the kit and the RA family of microcontrollers, download tools and 
documentation, and get support.  
 
Renesas Artificial Intelligence (AI)  renesas.com/ai 
AI Navigator    renesas.com/software-tools/ai-navigator 
RA Product Information    renesas.com/ra  
MCU Evaluation Kit                                  renesas.com/ra-kits 
RA Product Support Forum   renesas.com/ra/forum  
Renesas Support    renesas.com/support  
 
Provide Feedback/ Request a Feature 
Renesas aims to provide the best microcontroller kit experience to help jumpstart customer innovation with 
RA, RX & RL78 family of microcontrollers and take products to market faster. The Renesas microcontroller 
kits have been designed with a lot of attention-to-detail and customer-centric thinking in every aspect of 
design. Renesas aims to exceed customer expectations.  
Renesas looks forward to hearing your feedback and knowing how we can enhance your experience. Please 
share your feedback at renesas.com/ra/kitfeedback & renesas.com/rx/kitfeedback. 
 
 
 
 
 
 
 
  

   enum BufferSize_sub_0000 { 
     kBufferSize_sub_0000 = <intermediate_buffers_size> 
   }; 
 
   void compute_sub_0000( 
     // buffer for intermediate results 
     uint8_t* main_storage, // should provide at least <intermediate_buffers_size> bytes of storage 
 
     // inputs 
     const int8_t <input_name>[xxx], // 1,224,224,3 
 
     // outputs 
     int8_t <output_name>[xxx]  // 1,1000 
   ); 

Example 3: Definition of input/output buffers (in the file of model.h) 

 

 

  int8_t output_buffer[1000];    //StatefulPartitionedCall_0_70016; 
 
  compute_sub_0000(compute_buffer, input_buffer, output_buffer);   

Example 4: source code 

 

https://www.renesas.com/en/key-technologies/artificial-intelligence/real-time-analytics?srsltid=AfmBOorY8D4FDFCx1Rrmo1s2p3hSgmXc4H_BozepxaMFDohMaHYpYGPR
https://www.renesas.com/en/software-tool/ai-navigator-ide-ai-applications?srsltid=AfmBOor3tw8pBW94rqEw2Z0ydrYjqPS_pWlhMeuSeB1CAcmuq9TJfKFQ
https://www.renesas.com/en/products/microcontrollers-microprocessors/ra-cortex-m-mcus/ra-partners/irida-labs-qr-scanning
https://www.renesas.com/en/products/microcontrollers-microprocessors/ra-cortex-m-mcus/ra-kits
https://community.renesas.com/mcu-mpu/ra/
https://www.renesas.com/en/support
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Added RUHMI installation and update feature from GUI. 

  15 3.3.1 Open AI Navigator 

Improved GUI interface design. 

  18 3.3.3 Conversion 

Improved GUI interface design. 

  26 4.2 Downloading and Installing Software and Development Tools 

Improved the description to meet the instruction in the GitHub 
repository. 

  30 4.5 Generated inference API (Ethos-U Enabled) 

In Software Requirements, FSP version updated. 

  30 4.6 Generated inference API (CPU-Only) 

In Software Requirements, FSP version updated. 
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- Ubuntu 22.04 LTS for RA8 
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